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4 Google Ads

CoolSculpting Marketing Services

Cool Bodi Spa - Q1 2021
Total Marketing Expenses
(1/1/2021 - 3/31/2021)

Total Google Ads:
Total Marketing Service Fees:
Total CoolSculpting Marketing Cost:

$ 4,213.40
$ 3,000.00
$ 7,213.40

Chris Zelig > . 259-215-0574 Chris Zelig
Cool Bodi Sp... 7382726893 v All campaigns c 0 ‘ support@medstarmedia.com
a Campaigns Custom Jan1-Mar31,2021 v ¢ >
o\ ra
+ Y Campaign status: All  ADD FILTER i ‘ b6
SEARCH EXPAN
[:] ® Campaign Budget Status Clicks CTR J Cost
O o Y search | beta | coolsculpting $147.06/day Paused 742 4.04% $4213.40
#
O o Y search | beta | coolsculpting | exp reach $37.20/day Paused 0 = $0.00
Total: Campaigns & 742 4.04% $4,213.40
N Total: Account @ $0.00/day 742 4.04% $4,213.40
1-20f2

Reporting is not real-time. Time zone for all dates and times: (GMT-05:00) Central Time. Learn more
Some inventory may be provided through third party intermediaries.
You'll see Media Rating Council (MRC) accreditation noted in the column header's hover text for accredited metrics.

© Google, 2021.
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Overview # AdS Custom Jan1-Mar31,2021 +« ( >
Recommendations — e
+ Y Adstatus:All ADD FILTER Q = m [ .. £ ‘ v
SZARCH SEGMENT COLUMNS REPORTS  DOWNLOAD EXFAN
Insights
D ® Ad Campaign Ad group Status Clicks CTR J Cost
» Campaigns
Cool Bodi Spa | Fat Reduction in Norman, OK | Not eligible
Non-Surgical Fat Reduction +7 more Poor ad
Al etee [j ® cookiodispa.com search | beta | coolsculpting x. Expanded Reach Test strength 84 3.66% $403.28
Easy And Convenient. Long-Lasting. Minimal : ’ ; D = G .
e eriarions Downtime. Real Success Stories. FDA Cleare.. Campaign
View assets details paused
bl Ads Cool Bodi Spa | Fat Reduction in Norman, OK |
Non-Surgical Fat Reduction +7 more
www.coolbodispa.com X ; A
Assets D [ ] Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting 3. lipo 66 9.09% $367.94
Downtime. Real Success Stories. FDA Cleare...
Extensions View assets details
s Huge CoolSculpting Promotion | CoolSculpting
» Landing pages in Norman, OK | Biggest CoolSculpting®... RéiTioved
www.coolbodispa.com % s i 2 et 5
D (] Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 0. coolsculpting - genera Campaign 34 10.59% $246.82
» Keywords Stubborn Fat. Top Provider in Norman, OK.... paused
View assets details
» Audiences T | 3
Fat Reduction in Norman, OK | Our Biggest
Discount Ever | Freeze Away Body Fat
» Demographics www.coolbodispa.com Not eligible
D [ ] Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting x. Expanded Reach Test Campaign 28 3.22% $168.55
Removal. No Surgery. Minimal Downtime. Our paused
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Status Clicks CTR

J Cost

Fat Reduction in Norman, OK | Our Biggest
Discount Ever | Freeze Away Body Fat
www.coolbodispa.com

Best Prices. FDA-Cleared. Clinically Proven Fat
Removal. No Surgery. Minimal Downtime. Our
Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.

search | beta | coolsculpting X. Expanded Reach Test

Fat Reduction in Norman, OK | Our Biggest
Discount Ever | Freeze Away Body Fat
www.coolbodispa.com

Easy And Convenient. Long-Lasting. Minimal
Downtime. Real Success Stories. FDA Cleared.
Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today

search | beta | coolsculpting x. Expanded Reach Test

Fat Reduction in Norman, OK | Our Biggest
Discount Ever | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com

Easy And Convenient. Long-Lasting. Minimal
Downtime. Real Success Stories. FDA Cleared.
Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today

search | beta | coolsculpting X. Expanded Reach Test

Fat Reduction in Norman, OK | Our Biggest
Discount Ever | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com

Best Prices. FDA-Cleared. Clinically Proven Fat
Removal. No Surgery. Minimal Downtime. Our
Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.

search | beta | coolsculpting X. Expanded Reach Test
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[ ] Ad Campaign Ad group

Not eligible
Campaign
paused

28 3.22%

Not eligible
Campaign
paused

22 3.08%

Not eligible
Campaign
paused

19 291%

Not eligible
Campaign
paused

25 3.32%
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SEGMENT  COLUMNS

Status Clicks CTR

$168.55

$146.45

$125.40

$124.46

J Cost

Fat Reduction in Norman, OK | Our Biggest
Discount Ever | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com

Best Prices. FDA-Cleared. Clinically Proven Fat
Removal. No Surgery. Minimal Downtime. Our
Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.

search | beta | coolsculpting x. Expanded Reach Test

Fat Reduction in Norman, OK | Eliminate Fat &
Feel Great | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com

Easy And Convenient. Long-Lasting. Minimal
Downtime. Real Success Stories. FDA Cleared.
Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today

search | beta | coolsculpting x. Expanded Reach Test

Fat Reduction in Norman, OK | Our Biggest
Discount Ever | Get Rid of Unwanted Fat
www.coolbodispa.com

Best Prices. FDA-Cleared. Clinically Proven Fat
Removal. No Surgery. Minimal Downtime. Our
Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.

search | beta | coolsculpting x. Expanded Reach Test

Fat Reduction in Norman, OK | Freezing Fat
Really Works | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com

Easy And Convenient. Long-Lasting. Minimal
Downtime. Real Success Stories. FDA Cleared.
Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today

search | beta | coolsculpting x. Expanded Reach Test

Not eligible
Campaign
paused

25 3.32%

Not eligible
Campaign
paused

17 3.17%

Not eligible
Campaign
paused

13 1.61%

Not eligible
Campaign
paused

17 3.17%

$124.46

$115.01

$102.43

$99.66
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Insights
[:] [ ] Ad Campaign Ad group Status Clicks CTR J Cost
» Campaigns
Fat Reduction in Norman, OK | Eliminate Fat &
Feel Great | Get Rid of Unwanted Fat
» Ad groups www.coolbodispa.com Not eligible
[:] ® Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting x. Expanded Reach Test Campaign 1 2.37% $99.25
d : Downtime. Real Success Stories. FDA Cleared. paused
~ Ads &extensions s Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today
D Ads ) )
Huge CoolSculpting Promotion | CoolSculpting
in Norman, OK | Biggest CoolSculpting®... Paused
e D 0 mggg:gggﬁsgs;gg' Freeze Away search | beta | coolsculpting 0. coolsculpting - general Campaign 15 9.09% $92.61
Stubborn Fat. Top Provider in Norman, OK.... pased
Extensions View assets details
R di Huge CoolSculpting Promotion | CoolSculpting
Landing pages in Norman, OK | 2021 CoolSculpting Discount... Rk
0O e gg‘:’égg;gga]sgﬁ;ggl. Freeze Away search | beta | coolsculpting 1. coolsculpting - price Campaign 20 20.20% $§91.75
> Keywords Stubborn Fat. Top Provider in Norman, OK... P
View assets details
» Audiences
Fat Reduction in Norman, OK | Our Biggest
Discount Ever | Get Rid of Unwanted Fat
» Demographics www.coolbodispa.com Not eligible
[:] [ ] Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting 3. lipo Campaign 13 11.71% $81.30
Removal. No Surgery. Minimal Downtime. Our paused

» Settings Biggest CoolSculpting Discount Ever. Save
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CTR

J Cost

Insights Fat Reduction in Norman, OK | Our Biggest

Discount Ever | Get Rid of Unwanted Fat
www.coolbodispa.com

Best Prices. FDA-Cleared. Clinically Proven Fat
Removal. No Surgery. Minimal Downtime. Our
Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.

» Campaigns
» Ad groups
~ Ads & extensions

plAds D ®

Assets

Fat Reduction in Norman, OK | Our Biggest
Discount Ever | Get Rid of Unwanted Fat
www.coolbodispa.com

Easy And Convenient. Long-Lasting. Minimal
Downtime. Real Success Stories. FDA Cleared.
Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today

Fat Reduction in Norman, OK | Our Biggest
Discount Ever | Get Rid of Unwanted Fat
www.coolbodispa.com

Easy And Convenient. Long-Lasting. Minimal
Downtime. Real Success Stories. FDA Cleared.
Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today

Extensions
» Landing pages O e

» Keywords

Fat Reduction in Norman, OK | Freezing Fat
Really Works | Get Rid of Unwanted Fat
www.coolbodispa.com

Best Prices. FDA-Cleared. Clinically Proven Fat
Removal. No Surgery. Minimal Downtime. Qur
Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.

» Audiences
» Demographics O e

» Settings

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

3. lipo

x. Expanded Reach Test

3.lipo

x. Expanded Reach Test

Not eligible
Campaign
paused

Not eligible
Campaign
paused

Not eligible
Campaign
paused

Not eligible
Campaign
paused

1M1.71%

2.02%

8.20%

2.33%

$81.30

$79.36

§73.07

§72.13
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Fat Reduction in Norman, OK | Freezing Fat
Really Works | Get Rid of Unwanted Fat
www.coolbodispa.com

Best Prices. FDA-Cleared. Clinically Proven Fat
Removal. No Surgery. Minimal Downtime. Our
Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.

Fat Reduction in Norman, OK | Our Biggest
Discount Ever | Freeze Away Body Fat
www.coolbodispa.com

Easy And Convenient. Long-Lasting. Minimal
Downtime. Real Success Stories. FDA Cleared.
Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today

Fat Reduction in Norman, OK | Eliminate Fat &
Feel Great | Freeze Away Body Fat
www.coolbodispa.com

Easy And Convenient. Long-Lasting. Minimal
Downtime. Real Success Stories. FDA Cleared.
Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today

Fat Reduction in Norman, OK | Eliminate Fat &
Feel Great | Get Rid of Unwanted Fat
www.coolbodispa.com

Easy And Convenient. Long-Lasting. Minimal
Downtime. Real Success Stories. FDA Cleared.
Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

All campaigns

x. Expanded Reach Test

3. lipo

x. Expanded Reach Test

3. lipo

Q M@

SEARCH REPORTS

Not eligible
Campaign
paused

Not eligible
Campaign
paused

Not eligible
Campaign
paused

Not eligible
Campaign
paused
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2.33%

4.69%

2.24%

10.87%

259-215-0574 Chris Zelig
support@medstarmedia.com

§72.13

$66.94

$62.86

$61.44

Overview #f Ads Custom Jan1-Mar31,2021 +« ( >
i — ra
Recommendations + Y AdswstusAll ADDFILTER Q = 1] ¥ La ‘ <
SEARCH SEGMENT  COLUMNS DOWNLOAD EXPAND
Insights
[:] [ ] Ad Campaign Ad group Status Clicks CTR J Cost
» Campaigns
Fat Reduction in Norman, OK | Freezing Fat
Really Works | Freeze Away Body Fat
» Ad groups www.coolbodispa.com Not eligible
[:] ® Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting x. Expanded Reach Test Campaign 7 1.28% $56.85
: Downtime. Real Success Stories. FDA Cleared. paused
~ Ads & extensions s Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today
D Ads . )
Fat Reduction in Norman, OK | Freezing Fat
Really Works | Get Rid of Unwanted Fat
Assets www.coolbodispa.com Not eligible
E] ® Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting x. Expanded Reach Test Campaign 10 1.79% $55.01
Downtime. Real Success Stories. FDA Cleared. paused
Extensions Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today
> Landing pages Fat Reduction in Norman, OK | Freezing Fat
Really Works | Freeze Away Body Fat
S KeTvwords www.coolbodispa.com Not eligible
A E] ® Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting 3.lipo Campaign 7 9.86% $51.60
Downtime. Real Success Stories. FDA Cleared. paused
; Is Freezing Fat Right For You? Book a Free
» Audi
Ll CoolSculpting Consultation Today
» Demographics Fat Reduction in Norman, OK | Freezing Fat
Really Works | Offering $1,000 Off 8+ Cycles
: www.coolbodispa.com Not eligible
» Settings D [ ] Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting x. Expanded Reach Test Campaign 10 2.07% $48.90
- ' Chris Zelig > o 259-215-0574 Chris Zelig
= 4 Google Ads | o) Bodi Sp.. 7382726893 ¥ All campaigns support@medstarmedia.com
— ra
Overview A + Y Adstatus:All ADDFILTER Q = m kA ‘ v
SEARCH SEGMENT COoLUM EXPAND
Recommendations ) .
D ® Ad Campaign Ad group Status Clicks CTR J Cost
Insights
9 Fat Reduction in Norman, OK | Freezing Fat
Really Works | Offering $1,000 Off 8+ Cycles
» Campaigns www.coolbodispa.com Not eligible
D [ ] Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting x. Expanded Reach Test Campaign 10 207% $48.90
Removal. No Surgery. Minimal Downtime. Our paused
» Ad groups Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.
~ Ads &extensions Huge CoolSculpting Promotion | CoolSculpting
in Norman, OK | 2021 CoolSculpting Discount... Paused
www.coolbodispa.com : teptlnti i ) 5
p | Ads D 0 Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 1. coolsculpting - price C:&gzlgn 22 29.33% $48.71
Stubborn Fat. Top Provider in Norman, OK.... p
Assats View assets details
Fat Reduction in Norman, OK | Our Biggest
Extensions Discount Ever | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com Not eligible
D [ ] Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting 3. lipo Campaign 9 476% $45.41
» Landing pages Downtime. Real Success Stories. FDA Cleared. paused
Is Freezing Fat Right For You? Book a Free
K d CoolSculpting Consultation Today
eywords
Fat Reduction in Norman, OK | Eliminate Fat &
» Audiences Feel Great | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com Not eligible
[:] ® Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting 3. lipo Campaign 7 6.67% $43.04
» Demographics Downtime. Real Success Stories. FDA Cleared. paused

» Settings

Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today
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= 4 G I A d " A 259-215-0574 Chris Zelig
— oogle Ads | (coolBodiSp.. 732726803~ | All campaigns support@medstarmedia.com
— ra
Overview A + Y Adstatus:All ADDFILTER Q = m @ .. L4 ‘ v
SEARCH SEGMENT COLUMNS REPORTS DOWNLOAD EXPAND
oS e D [ ] Ad Campaign Ad group Status Clicks CTR J Cost
Insights
g Fat Reduction in Norman, OK | Eliminate Fat &
Feel Great | Offering $1,000 Off 8+ Cycles
» Campaigns www.coolbodispa.com Not eligible
D ® Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting 3. lipo Campaign 7 6.67% $43.04
Downtime. Real Success Stories. FDA Cleared. paused
» Ad groups Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today
~ Ads & extensions CoolSculpting® in Norman, OK | Feb Only
$1,000 Off 8+ Cycles | Flexible Payment...
b Ads www.coolbodispa.com Paused
O o Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 0. coolsculpting - general Campaign 4 8.70% $4291
Minimal Downtime. Eliminate Fat And Feel paused
Assets Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
Extensions CoolSculpting® in Norman, OK | Freeze Away
Body Fat | Flexible Payment Options
s www.coolbodispa.com Not eligible
» Landing pages D ® Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 0. coolsculpting - general Campaign 3 9.38% $42.82
Minimal Downtime. Eliminate Fat And Feel paused
S Pt Great. Don't Miss Our Biggest Promo Yet. Book
A a Free Consultation and Lock In Your Discoun...
» Audiences Fat Reduction in Norman, OK | Eliminate Fat &
Feel Great | Get Rid of Unwanted Fat
www.coolbodispa.com Not eligible
» Demographics O e Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting X. Expanded Reach Test Campaign 6 1.92% $39.50
Removal. No Surgery. Minimal Downtime. Our paused
Biggest CoolSculpting Discount Ever. Save
» Settings $1,000 Off 8+ Cycles of CoolSculpting.

p— Chris Zelig > . 259-215-0574 Chris Zelig
= 4 Google Ads | CoolBodisp.. 7zmems~ | All campaigns C @ A potemedsiamediaco
Overviow P Ads Custom Jan1-Mar31,2021 ~ ¢ )
Recommendations — £
+ Y Adstatus:All ADD FILTER Q = m M0 .. K ‘ v
SZARCK SEGMENT COLUMNS REPORTS DOWNLOAD EXPAND
Insights
D [ ] Ad Campaign Ad group Status Clicks CTR J Cost
» Campaigns
CoolSculpting® in Norman, OK | Limited Time
Offer | Jan 2021 | Flexible Payment Options
» Ad groups www.coolbodispa.com Removed
[:] [x] Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 0. coolsculpting - general Campaign 4 16.67% $37.87
d : Minimal Downtime. Eliminate Fat And Feel paused
~ Ads &extensions Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
Ads
D | CoolSculpting® in Norman, OK | Feb Only
$1,000 Off 8+ Cycles | Our Biggest Discount...
Assets www.coolbodispa.com Paused
D 0 Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 0. coolsculpting - general Campaign 6 15.00% $33.71
Minimal Downtime. Eliminate Fat And Feel paused
Extensions Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
» Landing pages Fat Reduction in Norman, OK | Freezing Fat
Really Works | Freeze Away Body Fat
S Kerwords www.coolbodispa.com Not eligible
A [:] ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting x. Expanded Reach Test Campaign 9 1.82% $33.43
Removal. No Surgery. Minimal Downtime. Our paused
» Audiences Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.
» Demographics Fat Reduction in Norman, OK | Freezing Fat
Really Works | Get Rid of Unwanted Fat
: www.coolbodispa.com Not eligible
» Settings D [ ] Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | cooisculpting 3.lipo Campaign 2 8.70% $32.86

Chris Zelig >

— . 259-215-0574 Chris Zelig
= 4 Google Ads | ¢ool Bodi Sp.. 7382726893 All campaigns support@medstammediia.com
— ra
Overview @ + Y Adstatus:All ADDFILTER Q = m @ ¥ L4 ‘ v
SEARCH SEGMENT COLUMNS  REPORTS  DOWNLOAD EXPAND
oSty i D ® Ad Campaign Ad group Status Clicks CTR J Cost
insights Fat Reduction in Norman, OK | Freezing Fat
Really Works | Get Rid of Unwanted Fat
» Campaigns www.coolbodispa.com Not eligible
E] ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | cooisculpting 3.lipo Campaign 2 8.70% $32.86
Removal. No Surgery. Minimal Downtime. Our paused
» Ad groups Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.
~ Ads & extensions Fat Reduction in Norman, OK | Our Biggest
Discount Ever | Freeze Away Body Fat
www.coolbodispa.com Not eligible
Ads D ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting 3. lipo Campaign 6 4.84% $31.32
Removal. No Surgery. Minimal Downtime. Qur paused
ASSars Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.
Extensions CoolSculpting® in Norman, OK | Limited Time
Offer | Jan 2021 | Our Biggest Discount Ever
www.coolbodispa.com Removed
» Landing pages l:] (%] Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 0. coolsculpting - general Campaign 4 17.39% $31.24
Minimal Downtime. Eliminate Fat And Feel paused
Great. Don't Miss Our Biggest Promo Yet. Book
» Keywords a Free Consultation and Lock In Your Discoun...
3 CoolSculpting® in Norman, OK | Freeze Away
> Audiences Body Fat | Flexible Payment Options
www.coolbodispa.com Not eligible
» Demographics D (2] Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 2. body sculpting Campaign 2 1.11% $29.36
Minimal Downtime. Eliminate Fat And Feel paused
Great. Dont Miss Our Biggest Promo Yet. Book
» Settings a Free Consultation and Lock In Your Discoun...

Chris Zelig > 259-215-0574 Chris Zelig

= 4 Google Ads | (cooipodisp.. 732726093~ | All campaigns support@medstarmedia.com
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Overview @ + Y AdstatustAll ADDFILTER Q = m @ . L4 ‘ v
SEARCH SEGMENT COLUMNS  REPORTS  DOWNLOAD EXPAND
S D [ ] Ad Campaign Ad group Status Clicks CTR J Cost
Insights CoolSculpting® in Norman, OK | Freeze Away
Body Fat | Flexible Payment Options
» Campaigns www.coolbodispa.com Not eligible
[:] ® Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 2. body sculpting Campaign 2 1M.11% $29.36
Minimal Downtime. Eliminate Fat And Feel paused
» Ad groups Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
~ Ads & extensions Non-Surgical Fat Reduction | Our Biggest
Discount Ever | Get Rid of Unwanted Fat
www.coolbodispa.com Not eligible
Ads D ® Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting 3. lipo Campaign 5 22.73% $28.80
Downtime. Real Success Stories. FDA Cleared. paused
Is Freezing Fat Right For You? Book a Free
Assets CoolSculpting Consultation Today
Extensions Non-Surgical Fat Reduction | Eliminate Fat &
Feel Great | Freeze Away Body Fat
www.coolbodispa.com Not eligible
» Landing pages D ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting x. Expanded Reach Test Campaign 5 481% $27.47
Removal. No Surgery. Minimal Downtime. Our paused
Biggest CoolSculpting Discount Ever. Save
» Keywords $1,000 Off 8+ Cycles of CoolSculpting.
v Rudi Fat Reduction in Norman, OK | Eliminate Fat &
Audiences Feel Great | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com Not eligible
» Demographics D ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting 3. lipo Campaign 4 16.67% $27.22
Removal. No Surgery. Minimal Downtime. Our paused
Biggest CoolSculpting Discount Ever. Save
» Settings $1,000 Off 8+ Cycles of CoolSculpting.

- ' Chris Zelig > o
= 4 Google Ads | o BodiSp.. 7382m26s03~ | All campaigns

259-215-0574 Chris Zelig
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Overviow P Ads Custom Jan1-Mar31,2021 ~ ¢ )
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Recommendations + Y AdststusAll ADDFILTER Q = m @ i ‘ <
SEARCH SEGMENT COLUMNS  REPORTS o] EXPAND
Insights
D ® Ad Campaign Ad group Status Clicks CTR J Cost
» Campaigns
Fat Reduction in Norman, OK | Freezing Fat
Really Works | Get Rid of Unwanted Fat
» Ad groups www.coolbodispa.com Not eligible
D ® Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting 3. lipo Campaign 4 5.71% $25.81
: Downtime. Real Success Stories. FDA Cleared. paused
~ Ads & extensions s Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today
p | g Non-Surgical Fat Reduction | Our Biggest
Discount Ever | Get Rid of Unwanted Fat
Assets www.coolbodispa.com Not eligible
E] [ ] Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting x. Expanded Reach Test Campaign 6 4.35% $25.64
Downtime. Real Success Stories. FDA Cleared. paused
Extensions Is Freezing Fat Right For You? Book a Free
CoolSculpting Consuitation Today
> Landing pages Non-Surgical Fat Reduction | Our Biggest
Discount Ever | Freeze Away Body Fat
» Keywords www.coolbodispa.com Not eligible
D ® Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting x. Expanded Reach Test Campaign 5 3.29% $25.00
Downtime. Real Success Stories. FDA Cleared. paused
> ; Is Freezing Fat Right For You? Book a Free
S CoolSculpting Consultation Today
» Demographics CoolSculpting® in Norman, OK | Limited Time
Offer | Feb 2021 | Hurry Offer Ends In...
www.coolbodispa.com Paused
» Settings l:] 0 Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 0. coolsculpting - general Campaign 2 25.00% $24.34
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oS e D [ ] Ad Campaign Ad group Status Clicks CTR J Cost
R CoolSculpting® in Norman, OK | Limited Time
Offer | Feb 2021 | Hurry Offer Ends In...
» Campaigns www.coolbodispa.com Paused
D 0 Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 0. coolsculpting - general Campaign 2 25.00% $24.34
Minimal Downtime. Eliminate Fat And Feel paused
» Ad groups Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
~ Ads & extensions Non-Surgical Fat Reduction | Eliminate Fat &
Feel Great | Freeze Away Body Fat
b Ads www.coolbodispa.com Not eligible
D ® Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting x. Expanded Reach Test Campaign 5 5.10% $23.98
Downtime. Real Success Stories. FDA Cleared. paused
Assets Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today
Extensions CoolSculpting® in Norman, OK | Limited Time
Offer | Feb 2021 | Our Biggest Discount Ever
www.coolbodispa.com Paused
» Landing pages D 0 Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 0. coolsculpting - general Campaign 3 27.27% $23.24
Minimal Downtime. Eliminate Fat And Feel paused
Great. Dont Miss Qur Biggest Promo Yet. Book
» Keywords a Free Consultation and Lock In Your Discoun...
> ; CoolSculpting® in Norman, OK | Limited Time
ALHETED Offer | Jan 2021 | Flexible Payment Options
www.coolbodispa.com Removed
» Demographics D 9 Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 3 17.65% $22.40
Minimal Downtime. Eliminate Fat And Feel paused

Great. Don't Miss Our Biggest Promo Yet. Book

» Settings a Free Consultation and Lock In Your Discoun..
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Overview # + Y Adstatus:All ADD FILTER Q
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¥
©

Recommendations ) .
D [ ] Ad Campaign Ad group Status Clicks CTR J Cost

Insights CoolSculpting® in Norman, OK | Limited Time

Offer | Jan 2021 | Flexible Payment Options

www.coolbodispa.com Removed

Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 3 17.65% $22.40
Minimal Downtime. Eliminate Fat And Feel paused

Great. Don't Miss Our Biggest Promo Yet. Book

a Free Consultation and Lock In Your Discoun...

» Campaigns D (x]
» Ad groups

~ Ads & extensions Fat Reduction in Norman, OK | Eliminate Fat &
Feel Great | Freeze Away Body Fat
www.coolbodispa.com Not eligible
D Ads D ® Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting 3. lipo Campaign 4 4.88% $22.15
Downtime. Real Success Stories. FDA Cleared. paused
Is Freezing Fat Right For You? Book a Free

Assets CoolSculpting Consultation Today

Fat Reduction in Norman, OK | Freezing Fat
Really Works | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com Not eligible
[ ] Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting 3.lipo Campaign 2 6.90% $21.76
Removal. No Surgery. Minimal Downtime. Our paused
Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.

Extensions
» Landing pages O

» Keywords

Fat Reduction in Norman, OK | Eliminate Fat &
Feel Great | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com Not eligible
[:] ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting x. Expanded Reach Test Campaign 5 1.46% $21.62
Removal. No Surgery. Minimal Downtime. Our paused
Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.

» Audiences

» Demographics

» Settings
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Recommendations — e :
+ Y Adstatus:All ADD FILTER Q = m 0 .. K ‘ v
SEARCK SEGMENT COLUMNS REPORTS DOWNLOAD EXPAND
Insights {
D @ Ad Campaign Ad group Status Clicks CTR J Cost
» Campaigns
Fat Reduction in Norman, OK | Freezing Fat
Really Works | Offering $1,000 Off 8+ Cycles
» Ad groups www.coolbodispa.com Not eligible
D ® Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting 3. lipo Campaign 3 492% $21.58
d ; Downtime. Real Success Stories. FDA Cleared. paused
~ Ads & extensions s Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today
D Ads . -
Fat Reduction in Norman, OK | Eliminate Fat &
Feel Great | Freeze Away Body Fat
Assets www.coolbodispa.com Not eligible
D ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting X. Expanded Reach Test Campaign 4 1.15% $19.62
Removal. No Surgery. Minimal Downtime. Our paused
Extensions Biggest CoolSculpting Discount Ever. Save
§1,000 Off 8+ Cycles of CoolSculpting.
> Landing pages Huge CoolSculpting Promotion | CoolSculpting
in Norman, OK | 2021 CoolSculpting Discount... Paused
www.coolbodispa.com tepiiii . : s
» Keywords [:] 0 Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 2. body sculpting C:S;’[ézlgn 3 27.27% $19.10
Stubborn Fat. Top Provider in Norman, OK.... P
» Audiences View assets details
Non-Surgical Fat Reduction | Our Biggest
» Demographics Discount Ever | Get Rid of Unwanted Fat
www.coolbodispa.com Not eligible
: D ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting X. Expanded Reach Test Campaign 5 4.46% $18.32
» Settings Removal. No Surgery. Minimal Downtime. Qur paused
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Ad

Campaign
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Status

Clicks

CTR

J Cost

Non-Surgical Fat Reduction | Our Biggest
Discount Ever | Get Rid of Unwanted Fat
www.coolbodispa.com

Best Prices. FDA-Cleared. Clinically Proven Fat
Removal. No Surgery. Minimal Downtime. Our
Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.

CoolSculpting® in Norman, OK | Jan Only
$1,000 Off 8+ Cycles | Hurry Offer Ends In...
www.coolbodispa.com

Expert, Safe Fat Loss With Quick Results.
Minimal Downtime. Eliminate Fat And Feel
Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...

Huge CoolSculpting Promotion | Freeze Away
Body Fat | Hurry Offer Ends In...
www.coolbodispa.com

Expert, Safe Fat Loss With Quick Results.
Minimal Downtime. Eliminate Fat And Feel
Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...

CoolSculpting® in Norman, OK | Limited Time
Offer | Feb 2021 | Hurry Offer Ends In...
www.coolbodispa.com

Expert, Safe Fat Loss With Quick Results.
Minimal Downtime. Eliminate Fat And Feel
Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

X. Expanded Reach Test

1. coolsculpting - price

0. coolsculpting - general

1. coolsculpting - price

Not eligible
Campaign
paused

Removed
Campaign
paused

Paused
Campaign
paused

Paused
Campaign
paused

5

2

4.46%

28.57%

100.00%

16.67%

$18.32

$17.70

$17.49

$16.19
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All campaigns
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SEARCH  SEGMENT  COLUMNS  REPORTS  DOWNLOAD  EXPAND

Recommendations . .
D [ ] Ad Campaign Ad group Status Clicks CTR J Cost

Insi
sights CoolSculpting® in Norman, OK | Limited Time

Offer | Feb 2021 | Hurry Offer Ends In...
www.coolbodispa.com Paused
O o Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 1 16.67% $16.19
Minimal Downtime. Eliminate Fat And Feel paused
Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...

» Campaigns
» Ad groups
~ Ads & extensions

Assets

Non-Surgical Fat Reduction | Our Biggest

Discount Ever | Freeze Away Body Fat

www.coolbodispa.com Not eligible

Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting 3. lipo Campaign 1 3.03% $15.68
Downtime. Real Success Stories. FDA Cleared. paused

Is Freezing Fat Right For You? Book a Free

CoolSculpting Consultation Today

Extensions Non-Surgical Fat Reduction | Our Biggest

Discount Ever | Offering $1,000 Off 8+ Cycles

www.coolbodispa.com Not eligible

Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting X. Expanded Reach Test Campaign 4 2.40% $14.87
Downtime. Real Success Stories. FDA Cleared. paused

Is Freezing Fat Right For You? Book a Free

CoolSculpting Consultation Today

» Landing pages 0O e
» Keywords

Non-Surgical Fat Reduction | Freezing Fat

Really Works | Offering $1,000 Off 8+ Cycles

www.coolbodispa.com Not eligible

Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting X. Expanded Reach Test Campaign 3 4.17% $14.13
Downtime. Real Success Stories. FDA Cleared. paused

Is Freezing Fat Right For You? Book a Free

CoolSculpting Consultation Today

» Audiences
» Demographics O e

» Settings
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Insights !
D [ ] Ad Campaign Ad group Status Clicks CTR J Cost
» Campaigns
CoolSculpting® in Norman, OK | Jan Only
$1,000 Off 8+ Cycles | Our Biggest Discount..
» Ad groups www.coolbodispa.com Removed
D [x] Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 0. coolsculpting - general Campaign 2 6.45% $13.51
7 Minimal Downtime. Eliminate Fat And Feel paused
~ Ads & extensions Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
p Ads o
CoolSculpting® in Norman, OK | Jan Only
$1,000 Off 8+ Cycles | Hurry Offer Ends In...
Assets www.coolbodispa.com Removed
D (] Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 0. coolsculpting - general Campaign 2 8.70% $13.06
Minimal Downtime. Eliminate Fat And Feel paused
Extensions Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
» Landing pages Cool Bodi Spa | Our Biggest Discount Ever | Get
Rid of Unwanted Fat
S Kevwords www.coolbodispa.com Not eligible
Yo D [ ] Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting 3.lipo Campaign 1 25.00% $12.72
Downtime. Real Success Stories. FDA Cleared. paused
» Audiences Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today
» Demographics CoolSculpting® in Norman, OK | Limited Time
Offer | Feb 2021 | Flexible Payment Options
: www.coolbodispa.com Paused
» Settings E] 0 Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 1 20.00% $11.23
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Recommendations . .
D [ ] Ad Campaign Ad group Status Clicks CTR J Cost
Insights
CoolSculpting® in Norman, OK | Limited Time
: Offer | Feb 2021 | Flexibie Payment Options
» Campaigns www.coolbodispa.com Paiisad
D 0 Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 1 20.00% $11.23
Minimal Downtime. Eliminate Fat And Feel paused
» Ad groups Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
~ Ads & extensions
. CoolSculpting® in Norman, OK | Freeze Away
Body Fat | Flexible Payment Options
D Ads www.coolbodispa.com Not eligible
E] ® Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 3 50.00% $11.22
Minimal Downtime. Eliminate Fat And Feel paused
Assets Great. Dont Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
Extensions CoolSculpting® in Norman, OK | Freeze Away
Body Fat | Our Biggest Discount Ever
5 it - www.coolbodispa.com Not eligible
AlGIH a0 O e Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 0. coolsculpting - general Campaign 2 8.70% $11.06
Minimal Downtime. Eliminate Fat And Feel paused
Great. Dont Miss Our Biggest Promo Yet. Book
AR a Free Consultation and Lock In Your Discoun...
» Audiences [Dynamically generated headling]
[Dynamically generated display URL] Not eligible
Sculpt Your Body. Freeze Fat Away Fat with T, , :
» Demographics D ® CoolSculpting. Eliminate Fat And Feel Great. Soarcl| betn | coplsausing el g:‘rjgzzlgn 1 16.67% $9.95
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[Dynamically generated headling]
[Dynamically generated display URL]

Sculpt Your Body. Freeze Fat Away Fat with
CoolSculpting. Eliminate Fat And Feel Great.
Best CoolSculpting Deal. Freeze Fat. Top
Provider in Norman, OK. Free Consult.

Non-Surgical Fat Reduction | Our Biggest
Discount Ever | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com

Easy And Convenient. Long-Lasting. Minimal
Downtime. Real Success Stories. FDA Cleared.
Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today

CoolSculpting® in Norman, OK | Limited Time
Offer | Feb 2021 | Hurry Offer Ends In...
www.coolbodispa.com

Expert, Safe Fat Loss With Quick Results.
Minimal Downtime. Eliminate Fat And Feel
Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...

Non-Surgical Fat Reduction | Eliminate Fat &
Feel Great | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com

Best Prices. FDA-Cleared. Clinically Proven Fat
Removal. No Surgery. Minimal Downtime. Our
Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

X. dynamic

3. lipo

2. body sculpting

x. Expanded Reach Test

Not eligible
Campaign
paused

Not eligible
Campaign
paused

Paused
Campaign
paused

Not eligible
Campaign
paused

16.67%

11.11%

50.00%

3.49%
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i — ra
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SEARCH SEGMENT COLUMNS REPORTS DOWNLOAD EXFAND
Insights !
O e Ad Campaign Ad group Status Clicks CTR J Cost
» Campaigns
Non-Surgical Fat Reduction | Eliminate Fat &
Feel Great | Get Rid of Unwanted Fat
» Ad groups www.coolbodispa.com Not eligible
[:] ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting x. Expanded Reach Test Campaign 2 2.08% $9.44
: Removal. No Surgery. Minimal Downtime. Our paused
~ Ads & extensions Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.
b | B Huge CoolSculpting Promotion | Limited Time
Offer | Jan 2021 | Flexible Payment Options
Assets www.coolbodispa.com Removed
E] (] Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 0. coolsculpting - general Campaign 1 20.00% $9.13
Minimal Downtime. Eliminate Fat And Feel paused
Extensions Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
> Landing pages Non-Surgical Fat Reduction | Freezing Fat
Really Works | Offering $1,000 Off 8+ Cycles
» Keywords www.coolbodispa.com ) Not eligible
D ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting x. Expanded Reach Test Campaign 2 2.70% $8.95
Removal. No Surgery. Minimal Downtime. Qur paused
> ; Biggest CoolSculpting Discount Ever. Save
LHET $1,000 Off 8+ Cycles of CoolSculpting.
» Demographics CoolSculpting® in Norman, OK | Freeze Away
Body Fat | Flexible Payment Options
www.coolbodispa.com Not eligible
» Settings D [ ] Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 0. coolsculpting - general Campaign 3 30.00% $8.84
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CoolSculpting® in Norman, OK | Freeze Away
Body Fat | Flexible Payment Options
www.coolbodispa.com

Best CoolSculpting Deal. Freeze Away
Stubborn Fat. Top Provider in Norman, OK.
How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...

CoolSculpting® in Norman, OK | Jan Only
$1,000 Off 8+ Cycles | Our Biggest Discount..
www.coolbodispa.com

Expert, Safe Fat Loss With Quick Results.
Minimal Downtime. Eliminate Fat And Feel
Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...

CoolSculpting® in Norman, OK | Limited Time
Offer | Feb 2021 | Hurry Offer Ends In...
www.coolbodispa.com

Best CoolSculpting Deal. Freeze Away
Stubborn Fat. Top Provider in Norman, OK.
How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...

CoolSculpting® in Norman, OK | Feb Only
$1,000 Off 8+ Cycles | Hurry Offer Ends In...
www.coolbodispa.com

Expert, Safe Fat Loss With Quick Results.
Minimal Downtime. Eliminate Fat And Feel
Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

0. coolsculpting - general

1. coolsculpting - price

1. coolsculpting - price

1. coolsculpting - price

Not eligible
Campaign
paused

Removed
Campaign
paused

Paused
Campaign
paused

Paused
Campaign
paused

30.00%

23.08%

44.44%

7.14%

$8.84

$8.84

$7.79

$7.57
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CoolSculpting® in Norman, OK | Feb Only
$1,000 Off 8+ Cycles | Hurry Offer Ends In...
www.coolbodispa.com

Expert, Safe Fat Loss With Quick Results.
Minimal Downtime. Eliminate Fat And Feel
Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...

Cool Bodi Spa | Freezing Fat Really Works |
Freeze Away Body Fat

www.coolbodispa.com

Easy And Convenient. Long-Lasting. Minimal
Downtime. Real Success Stories. FDA Cleared.
Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today

CoolSculpting® in Norman, OK | Jan Only
$1,000 Off 8+ Cycles | Flexible Payment...
www.coolbodispa.com

Expert, Safe Fat Loss With Quick Results.
Minimal Downtime. Eliminate Fat And Feel
Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...

Non-Surgical Fat Reduction | Eliminate Fat &
Feel Great | Get Rid of Unwanted Fat
www.coolbodispa.com

Easy And Convenient. Long-Lasting. Minimal
Downtime. Real Success Stories. FDA Cleared.
Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today
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3. lipo
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X. Expanded Reach Test

Paused
Campaign
paused

Not eligible
Campaign
paused

Removed
Campaign
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Not eligible
Campaign
paused

cC 0
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7.14%

50.00%

9.09%
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$7.57
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O e Ad Campaign Ad group Status Clicks CTR J Cost
CoolSculpting® in Norman, OK | Freeze Away
Body Fat | Our Biggest Discount Ever
www.coolbodispa.com Not eligible

E] ® Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 2. body sculpting Campaign 1 11.11% $6.77
Minimal Downtime. Eliminate Fat And Feel paused
Great. Dont Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
Non-Surgical Fat Reduction | Our Biggest
Discount Ever | Freeze Away Body Fat
www.coolbodispa.com Not eligible

D ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting x. Expanded Reach Test Campaign 2 1.83% $6.63
Removal. No Surgery. Minimal Downtime. Our paused
Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.
CoolSculpting® in Norman, OK | Feb Only
$1,000 Off 8+ Cycles | Flexible Payment...
www.coolbodispa.com Paused

D 0 Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 2. body sculpting Campaign 2 100.00% $6.50
Minimal Downtime. Eliminate Fat And Feel paused
Great. Dont Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
CoolSculpting® in Norman, OK | Jan Only
$1,000 Off 8+ Cycles | Our Biggest Discount...
www.coolbodispa.com Removed

D (%] Best CoolSculpting Deal. Freeze Away search | beta | cooisculpting 1. coolsculpting - price Campaign 1 33.33% $6.45
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CoolSculpting® in Norman, OK | Jan Only
$1,000 Off 8+ Cycles | Our Biggest Discount...
www.coolbodispa.com

Best CoolSculpting Deal. Freeze Away
Stubborn Fat. Top Provider in Norman, OK.
How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...

Cool Bodi Spa | Our Biggest Discount Ever |
Offering $1,000 Off 8+ Cycles
www.coolbodispa.com

Easy And Convenient. Long-Lasting. Minimal
Downtime. Real Success Stories. FDA Cleared.
Is Freezing Fat Right For You? Book a Free
CoolSculpting Consultation Today

CoolSculpting® in Norman, OK | Freeze Away
Body Fat | Our Biggest Discount Ever
www.coolbodispa.com

Best CoolSculpting Deal. Freeze Away
Stubborn Fat. Top Provider in Norman, OK.
How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...

CoolSculpting® in Norman, OK | Freeze Away
Body Fat | Our Biggest Discount Ever
www.coolbodispa.com

Best CoolSculpting Deal. Freeze Away
Stubborn Fat. Top Provider in Norman, OK.
How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

All campaigns

1. coolsculpting - price

3. lipo

0. coolsculpting - general

1. coolsculpting - price

Removed
Campaign
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Campaign
paused
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Recommendations
D [ ] Ad Campaign Ad group Status Clicks CTR J Cost
Insights A YOU MM TTMK. BOOK A FTee..
CoolSculpting® in Norman, OK | Freeze Away
» Campaigns Body Fat | Our Biggest Discount Ever
www.coolbodispa.com Not eligible
[:] ® Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 1. coolsculpting - price Campaign 2 20.00% $6.00
» Ad groups Stubborn Fat. Top Provider in Norman, OK. paused
How Much Does CoolSculpting Cost? Less
: Than You Might Think. Book A Free...
~ Ads & extensions
CoolSculpting® in Norman, OK | Limited Time
D Ads Offer | Jan 2021 | Our Biggest Discount Ever
www.coolbodispa.com Removed
D (%] Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 2 16.67% $5.62
Assets Minimal Downtime. Eliminate Fat And Feel paused
Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
Extensions
[Dynamically generated headling]
: [Dynamically generated display URL] L
> Landing pages Best CoolScuipting Deal. Top Provider in A Not eligible
D ® Norman, OK for Fat Freezing. Free Consuit Top search | beta | coolsculpting X. dynamic Caalrjr;gzlgn 2 22.22% $5.56
' K d Fat Reduction Treatment. Target Love Handles, P
EFOEES Arms, Bra Bulge, Double Chin, & More
» Audiences Fat Reduction in Norman, OK | Our Biggest
Discount Ever | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com Not eligible
» Demographics D ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting 3.lipo Campaign 2 1.77% $5.55
Removal. No Surgery. Minimal Downtime. Qur paused

» Settings

Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.
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Insights t
D [ ] Ad Campaign Ad group Status Clicks CTR J Cost
» Campaigns
CoolSculpting® in Norman, OK | Limited Time
A Offer | Feb 2021 | Our Biggest Discount Ever
’ groups www.coolbodispa.com Paused
D 0 Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 0. coolsculpting - general Campaign 1 20.00% 85.51
: Stubborn Fat. Top Provider in Norman, OK. paused
~ Ads &extensions How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...
Ads
D | CoolSculpting® in Norman, OK | Jan Only
$1,000 Off 8+ Cycles | Flexible Payment...
Assets www.coolbodispa.com Removed
[:] (%] Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 0. coolsculpting - general Campaign 2 18.18% $5.30
Stubborn Fat. Top Provider in Norman, OK. paused
Extensions How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...
Q= (B Huge CoolSculpting Promotion | CoolSculpting Removed
inNorman, OK | 2021 CoolSculpting Discount... Poor ad
» Keywords www.coolbodispa.com R ; S | o
yw D 9 Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 2. body sculpting ;31(@;19@1 1 5.26% $5.20
Stubborn Fat. Top Provider in Norman, OK.... Campaign
» Audiences View assets details paused
S e Fat Reduction in Norman, OK | Eliminate Fat &
EMOGTERINcE Feel Great | Get Rid of Unwanted Fat
www.coolbodispa.com Not eligible
E] ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting 3. lipo Campaign 1 9.09% $4.92

» Settings

Removal. No Surgery. Minimal Downtime. Our

paused
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Insights Fat Reduction in Norman, OK | Eliminate Fat &
Feel Great | Get Rid of Unwanted Fat
i www.coolbodispa.com Not eligible
% Campaigng D ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting 3.lipo Campaign 1 9.09% $4.92
Removal. No Surgery. Minimal Downtime. Our paused
» Ad aroups Biggest CoolSculpting Discount Ever. Save
TR $1,000 Off 8+ Cycles of CoolSculpting.
~ Ads & extensions Best CoolSculpting Deal Ever | Limited Time
Offer | Jan 2021 | Flexible Payment Options
www.coolbodispa.com Removed
Ads D [x] Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 0. coolsculpting - general Campaign 1 50.00% $4.79
ubborn Fat. Top Provider in Norman, OK. pause
Stubborn Fat. Top Providerin N 0K d
How Much Does CoolSculpting Cost? Less
Assets Than You Might Think. Book A Free...
; CoolSculpting® in Norman, OK | Limited Time
Extensions p :
Offer | Feb 2021 | Flexible Payment Options
www.coolbodispa.com Paused
» Landing pages D 0 Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 1. coolsculpting - price Campaign 2 33.33% $4.55
Stubborn Fat. Top Provider in Norman, OK. paused
How Much Does CoolSculpting Cost? Less
» Keywords Than You Might Think. Book A Free...
; CoolSculpting® in Norman, OK | Limited Time
» Audiences Offer | Jan 2021 | Hurry Offer Ends In...
www.coolbodispa.com Removed
I hi D (] Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 1. coolsculpting - price Campaign 1 16.67% $4.05
emographics Stubborn Fat. Top Provider in Norman, OK. paused
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CoolSculpting® in Norman, OK | Limited Time
Offer | Jan 2021 | Hurry Offer Ends In...
www.coolbodispa.com

Best CoolSculpting Deal. Freeze Away
Stubborn Fat. Top Provider in Norman, OK.
How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...

Best CooiSculpting Deal Ever | Limited Time
Offer | Jan 2021 | Hurry Offer Ends In...
www.coolbodispa.com

Expert, Safe Fat Loss With Quick Results.
Minimal Downtime. Eliminate Fat And Feel
Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...

CoolSculpting® in Norman, OK | Limited Time
Offer | Jan 2021 | Flexible Payment Options
www.coolbodispa.com

Best CoolSculpting Deal. Freeze Away
Stubborn Fat. Top Provider in Norman, OK.
How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...

Huge CoolSculpting Promotion | Limited Time
Offer | Feb 2021 | Our Biggest Discount Ever
www.coolbodispa.com

Best CoolSculpting Deal. Freeze Away
Stubborn Fat. Top Provider in Norman, OK.
How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...

search | beta | coolsculpting
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All campaigns

1. coolsculpting - price
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Removed
Campaign
paused
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SEARCH SEGMENT COLUMNS REPORTS DOWNLOAD EXFAND
Insights
D ® Ad Campaign Ad group Status Clicks CTR J Cost
» Campaigns
Non-Surgical Fat Reduction | Freezing Fat
Really Works | Get Rid of Unwanted Fat
» Ad groups www.coolbodispa.com Not eligible
D ® Best Prices. FDA-Cleared. Clinically Proven Fat search | beta | coolsculpting x. Expanded Reach Test Campaign 1 1.25% $3.78
- Ad % Removal. No Surgery. Minimal Downtime. Our paused
Ads & extensions Biggest CoolSculpting Discount Ever. Save
$1,000 Off 8+ Cycles of CoolSculpting.
b Ads o
CoolSculpting® in Norman, OK | Feb Only
$1,000 Off 8+ Cycles | Hurry Offer Ends In...
Assets www.coolbodispa.com Paused
D 0 Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 0. coolsculpting - general Campaign 1 12.50% $3.55
Stubborn Fat. Top Provider in Norman, OK. paused
Extensions How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...
» Landing pages CoolSculpting® in Norman, OK | Feb Only
$1,000 Off 8+ Cycles | Flexible Payment...
S KeTvords www.coolbodispa.com Paused
i D 0 Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 1 7.69% $3.49
Minimal Downtime. Eliminate Fat And Feel paused
; Great. Don't Miss Our Biggest Promo Yet. Book
»
S a Free Consultation and Lock In Your Discoun...
» Demographics CoolSculpting® in Norman, OK | Limited Time
Offer | Jan 2021 | Our Biggest Discount Ever
: www.coolbodispa.com Removed
» Settings D (%] Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 0. coolsculpting - general Campaign 1 11.11% $2.46
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CoolSculpting® in Norman, OK | Limited Time
Offer | Jan 2021 | Our Biggest Discount Ever
www.coolbodispa.com

Best CoolSculpting Deal. Freeze Away
Stubborn Fat. Top Provider in Norman, OK.
How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...

Huge CoolSculpting Promotion | Freeze Away
Body Fat | Hurry Offer Ends In...
www.coolbodispa.com

Best CoolSculpting Deal. Freeze Away
Stubborn Fat. Top Provider in Norman, OK.
How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...

CoolSculpting® in Norman, OK | Feb Only
$1,000 Off 8+ Cycles | Flexible Payment...
www.coolbodispa.com

Best CoolSculpting Deal. Freeze Away
Stubborn Fat. Top Provider in Norman, OK.
How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...

CoolSculpting® in Norman, OK | Freeze Away
Body Fat | Our Biggest Discount Ever
www.coolbodispa.com

Expert, Safe Fat Loss With Quick Results.
Minimal Downtime. Eliminate Fat And Feel
Great. Dont Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

search | beta | coolsculpting

0. coolsculpting - general

1. coolsculpting - price

1. coolsculpting - price

1. coolsculpting - price

Removed
Campaign
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Removed
Campaign
paused
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Campaign
paused
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Campaign
paused
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Overview @ + Y Adstatus:All ADD FILTER m h o L4 ‘ v
SEARCH SEGMENT COLUMNS REPORTS DOWNLOAD EXPAND
S [:] ® Ad Campaign Ad group Status Clicks CTR J Cost
Insights CoolSculpting® in Norman, OK | Freeze Away
Body Fat | Our Biggest Discount Ever
» Campaigns www.coolbodispa.com _ ; Not eligible
D ® Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 2 18.18% 8217
Minimal Downtime. Eliminate Fat And Feel paused
» Ad groups Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
~ Ads & extensions Best CoolSculpting Deal Ever | Limited Time
Offer | Jan 2021 | Hurry Offer Ends In...
www.coolbodispa.com Removed
Ads D (%] Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 1. coolsculpting - price Campaign 1 50.00% $2.10
Stubborn Fat. Top Provider in Norman, OK. paused
How Much Does CoolSculpting Cost? Less
Assets Than You Might Think. Book A Free...
Extensions Best CoolSculpting Deal Ever | Feb Only $1,000
Off 8+ Cycles | Flexible Payment Options
www.coolbodispa.com Paused
» Landing pages D 0 Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 1 50.00% $2.08
Minimal Downtime. Eliminate Fat And Feel paused
Great. Dont Miss Our Biggest Promo Yet. Book
» Keywords a Free Consultation and Lock In Your Discoun...
s Audi Best CoolSculpting Deal Ever | Freeze Away
Audiences Body Fat | Our Biggest Discount Ever
www.coolbodispa.com Not eligible
» Demographics D ® Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 1. coolsculpting - price Campaign 1 100.00% $1.87
Stubborn Fat. Top Provider in Norman, OK. paused

» Settings

How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...
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CoolSculpting® in Norman, OK | Limited Time
Offer | Feb 2021 | Our Biggest Discount Ever
» Ad groups www.coolbodispa.com Paused
D 0 Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 2 33.33% $1.64
Minimal Downtime. Eliminate Fat And Feel paused
Great. Don't Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...
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STARCK  SEGMENT  COLUMNS  REPORTS  DOWNLOAD  EXPAND
Insights
D [ ] Ad Campaign Ad group Status Clicks CTR J Cost ’
» Campaigns ’

~ Ads & extensions

b | g Best CoolSculpting Deal Ever | Freeze Away
Body Fat | Hurry Offer Ends In...
Assets www.coolbodispa.com Paused
D 0 Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 1. coolsculpting - price Campaign 1 50.00% $1.57
Stubborn Fat. Top Provider in Norman, OK. paused
Extensions How Much Does CoolSculpting Cost? Less
Than You Might Think. Book A Free...

» Landing pages Best CoolSculpting Deal Ever | Jan Only $1,000
Off 8+ Cycles | Our Biggest Discount Ever
» Keywords www.coolbodispa.com Removed
D (%] Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 1 50.00% $0.91
Minimal Downtime. Eliminate Fat And Feel paused
> ; Great. Dont Miss Our Biggest Promo Yet. Book
S a Free Consultation and Lock In Your Discoun...
» Demographics Huge CoolSculpting Promotion | Freeze Away
Body Fat | Our Biggest Discount Ever
www.coolbodispa.com Not eligible
» Settings D ® Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 1 33.33% $0.88
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SEARCH  SEGMENT
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Insights
9 Huge CoolSculpting Promotion | Freeze Away

Body Fat | Our Biggest Discount Ever
» Campaigns www.coolbodispa.com Not eligible
D (3] Expert, Safe Fat Loss With Quick Results. search | beta | coolsculpting 1. coolsculpting - price Campaign 1 33.33% $0.88
Minimal Downtime. Eliminate Fat And Feel paused
» Ad groups Great. Dont Miss Our Biggest Promo Yet. Book
a Free Consultation and Lock In Your Discoun...

~ Ads &extensions CoolSculpting® in Norman, OK | Freeze Away
Body Fat | Flexible Payment Options
9 Ad www.coolbodispa.com Not eligible
& D ® Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 1. coolsculpting - price Campaign 1 14.29% $0.85
Stubborn Fat. Top Provider in Norman, OK. paused
How Much Does CoolSculpting Cost? Less

SIS Than You Might Think. Book A Free...

Extensions Non-Surgical Fat Reduction | Eliminate Fat &
Feel Great | Offering $1,000 Off 8+ Cycles
www.coolbodispa.com Not eligible
» Landing pages D ® Easy And Convenient. Long-Lasting. Minimal search | beta | coolsculpting 3. lipo Campaign 1 12.50% $0.66
Downtime. Real Success Stories. FDA Cleared. paused
Is Freezing Fat Right For You? Book a Free
» Keywords CoolSculpting Consultation Today

CoolSculpting® in Norman, OK | Limited Time
Offer | Jan 2021 | Our Biggest Discount Ever
www.coolbodispa.com Removed
» Demoaraphics O e Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 1. coolsculpting - price Campaign 1 12.50% $0.32
grap G
Stubborn Fat. Top Provider in Norman, OK. paused
How Much Does CoolSculpting Cost? Less
» Settings Than You Might Think. Book A Free...
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Insights [:] 9 Best CoolSculpting Deal. Freeze Away search | beta | coolsculpting 1. coolsculpting - price Campaign 1 12.50% $0.32
Stubborn Fat. Top Provider in Norman, OK. paused
% How Much Does CoolSculpting Cost? Less
» Campaigns Than You Might Think. Book A Free...
» Ad aroups #1 Provider in Norman | Safe & Effective Fat
TR Reduction | 25% Off All CooISculpting® +9.. s
A& extentions D Q :r?ocl%%?,si%?bctﬁ]n;l[gggsérﬂg;?gg To;gn;n search | beta | coolsculpting 0. coolsculpting - general Campaign 0 = $0.00
- i ; :
Provider in Norman , OK. Free Consult. Expert,... patied
View assets details
D Ads
#1 Provider in Norman | Safe & Effective Fat Removed
ASgate Redluctiqn | 25% Olff Al: CoolSpqutir}g@ +9.. Ad group
0 e 2‘1’°C%%‘|”S‘°’£p°tﬁ]’;’[§:; provsnclog search | beta| coolsculpting coolsculpting - face removed, 0 - $0.00
Eanmane Provider in Norman , OK. Free Consult. Expert,... Campaign
View assets details paused
» Landing pages 25% Off All CoolSculpting® | Best Price in
Norman, OK | Coolbodispa +6 more Removed
coolbodispa.com/coolsculpting/special S : :
» Keywords D Q Personajlizped Tre:-;tments. L%xu?y Spemng, search | beta | coolsculpting 1. coolsculpting - price Campaign 0 = $0.00
Trained Specialists. Easy And Convenient.... paRed
» Audiences View assets details
: Total: Ads (® 742 4.04% $4,213.40
» Demographics
v Total: Account & 742 4.04% $4,213.40
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Ads Sitelink extension
9 Extensions CoolSculpting
D CoolSculpting: The Top Non-Surgical »  Sitelink extension search | beta|cool..  Campaign Approved 1 3.70% $13.99

Fat Reduction Treatment. Learn More
» Landing pages

Call extension
» Keywords
O 5;00531;;2)0-9785 Call extension Account Account Approved 63 3.46% $492.09
» Audiences :
(405) 420-9785 Call extension Account Account Approved 4 4.80% $264.76
» Demographics
Callout extension
Settings
D FDA Cleared Callout extension search | beta| cool.. ~ Campaign Approved 194 4.26% $1,300.05
Suggested
» Ad schedule D Freeze Your Fat Callout extension search|beta|cool.. ~ Campaign Approved 162 401% $1,127.37
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Insights
9 D Extension Extension type Added to Level Status Clicks CTR J Cost
» Ad groups
A Callout extension
~ Ads & extensions
i O FDA Cleared Callout extension search | beta|cool.. ~ Campaign Approved 194 4.26% $1,300.05
S
D : O Freeze Your Fat Callout extension search | beta|cool..  Campaign Approved 162 401% $1,127.37
Extensions
s O Nonsurgical Fat Reduction Callout extension search | beta|cool. ~ Campaign Approved 139 3.97% $928.27
» Landing pages
5 Approved
» Keywords i ) ) (limited): Health in
D Highlights: No Surgery Callout extension search | beta|cool.. =~ Campaign personalized 139 3.86% $912.73
. advertising
» Audiences
App_roved )
» Demographics 0 Liposuction Afternative Callout extension search | beta|cool.  Campaign gg’?gﬁ?@?"h " 137 386% $906.13
advertising
Settings
D New Clients 25% Off Callout extension search | beta|cool.. ~ Campaign Approved 139 3.70% $900.19
Suggested

» Ad schedule D Contact Us + Free Consult Callout extension search | beta| cool.. ~ Campaign Approved 130 3.76% $863.67
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Y x SUMMARY TABLE
Insights
— r1 3
° Y Extension type: Al ADD FILTER Associations view v - m m . b .
» Ad groups SEGMENT  COLUMNS  REPORTS  DOWNLOAD  EXPAND  MORE
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Medstar Media, INC.

10808 S. River Front Parkway Suite 3020
South Jordan, UT 84095

+1 6466949450
support@medstarmedia.com

BILL TO INVOICE # FB2021-008
CoolBodiSpa DATE 01/01/2021

DUE DATE 01/01/2021

TERMS FB Customer

ACTIVITY DESCRIPTION QTY RATE AMOUNT
Digital Marketing 1 1,500.00 1,500.00
Monthly
Management

7 IENT 1,500.00
CE DUE $0 00



Medstar Media, INC.

10808 S. River Front Parkway Suite 3020
South Jordan, UT 84095

+1 6466949450
support@medstarmedia.com

BILL TO INVOICE # FB2021-029
CoolBodiSpa DATE 02/01/2021

DUE DATE 02/01/2021

TERMS FB Customer

ACTIVITY DESCRIPTION QTY RATE AMOUNT
Digital Marketing 1 1,500.00 1,500.00
Monthly
Management

7 IENT 1,500.00
CE DUE $0 00



